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Not now, silly.    When you are in a dialog box in the BCGopher application!



If this button appears on a dialog box in BCGopher, you can click on it and get help about that dialog 
box.



What is Gopher+?

gopher+  n.  1. Hardier strains of mammals of the family Geomyidae.  2. (Amer. 
colloq.) Native or inhabitant of Minnesota, the Gopher state, in full winter 
regalia (see PARKA).  3. (Amer. colloq.) Executive secretary.  4. (computer tech.)
Software following a simple protocol for burrowing through a TCP/IP internet, made
more powerful by simple enhancements (see CREEPING FEATURISM).

When you start navigating throughout gopherspace you will encounter then following file
types and services.    Click on an icon to find out more about it.

There are files .

There are folders  and links to other gopher servers 

.

There are Indexed Search pointers .

There are CSO Phone Book pointer .

There are Telnet  and TN3270 

 pointers.

There are other operating system based files also:

A BINHEX file .

A UUENCODED file .

A DOSBINARY file     and straight BINARY 

.

Included in the gopher protocol is support for graphic images 

,    sounds 

, and movies 

.    These file types are also considered to be binary files.    These files sometimes are in 
formats that multiple computers can read (such as GIF for images and AU for sounds, or 



QuickTime for movies).

Some extended Item Types are  Hypertext Markup Language (HTML) used in the World 
Wide Web, 

 MIME, and 

 messages.



The term gopherspace refers to the many different menus and services you can navigate
through using a gopher client.



 A file is a document that contains text.    This text can be in the form of an ASCII 
readable documents or other text encoded types.    The value for an item of this type is 
"0".



 A folder is an item that contains more files and / or folders.    A folder can also be a 
pointer to different gopher server at another the same site or at a different site.    The 

value for an item of this type is "1".



 This service is a query engine that will return documents pertaining to the search string 
and the particular search.    The value for an item of this type is "7".

See Also:
Indexed Search



 A CSO Phone Book is server developed at the Computer and Communications Services 
Office at the University of Illinois at Urbana and can be accessed by a client called a PH 
client.    BCGopher has built into it the ability to query these phone books.    In most 
cases these phone books contain information about Faculty, Staff, Students, or 
Employees at a particular site.    The value for an item of this type is "2".

See Also
CSO Phone Book Searches



 These pointers contain information for a telnet connection.    BCGopher will launch the 
telnet or TN3270 application you specify in the Application Association section of the 
Configuration Dialog Box and automatically connect to the site pointed to.    The value for

an item of this type is "8".



 This is a text file encoded in the BINHEX format.    These files are typically for 
Macintoshes.    Though BCGopher cannot decode these files, you can receive them in 
case you wish to move them to a Macintosh later.    The value for an item of this type is 
"4".



 This is a text file encoded in the UUENCODE format.    This file can be decoded on many 
types of machines.    This is typically a UNIX file, but can also be a DOS file.    The value 
for an item of this type is "6".



 These are files that cannot be displayed on your screen and must be captured directly to
your computer.    In most cases these may be program files and will be operating system 
dependent.The value for an item of this type DOS binary is "5".    The value for an item of 
type binary is "9".



 A graphic picture in binary form.    Usually in a graphics format readable by many 
different computers (such as GIF or JPG, or some other image form).    With BCGopher 
you need an external program to view this type of file which you can set in the 
Application Association section of the Configuration Dialog Box.    The value for an 
item of this type is "I".

 This icon specifically represents a GIF file, while the other icon represents any kind of 
image.    This format was added for compatibility's sake.    The value for an item of this 
type is "g".



 A sound file is in binary form.    Usually in a sound format readable by many different 
computers (such as AU).    With BCGopher you need an external program to hear this 
type of file which you can set in the Application Association section of the 
Configuration Dialog Box.    The value for an item of this type is "s".



 A movie file is in binary form.    Usually in a movie format readable by multiple types of 
computers (suck as QuickTime).    With BCGopher you need an external program to view
this type of file which you can set in the Application Association section of the 
Configuration Dialog Box.    The value for an item of this type is ";".



 An error or unsupported item.    If there was an error in transmission, or a problem at the 
server the trashcan may appear.    If the item has been transmitted correctly, but the 
item is not supported by BCGopher the bars will appear.    The value for an item of this 

type is "3".



 Hypertext Markup Language (HTML) is the language used when creating Hypertext 
documents displayable on the World Wide Web (WWW), which is readable by the Mosaic 
suite of WWW viewers.    The value for an item of this type is "h".



 MIME is an encoding scheme used in sending non text documents through mail.    The 
value for an item of this type is "M".



 An Inline item is an informational line that has no document associated with it.    This can
be used for short, quick instructional messages.    This type was first proposed by the 
Panda Project at the University of Iowa.    The value for an item of this type is "i".



Connecting to a Gopher Server (or other service)

If you have just started with BCGopher you should be given a blank window.    This 
window is where the gopher menu items will reside.    To connect you can use the New 
Gopher menu item in the File Menu.    Alternatively, you can have BCGopher connect to 
your favorite site every time you start it up.    The way to do this is to check the Connect
on Startup check box in the Configuration Dialog Box.

Once you have been connected to a server you will see (in most cases) the top level of 
the server.    This typically consists of a file describing the server and a number of folders 
ordered by subject.

It is also possible to startup BCGopher with a series of command line parameters 
informing it where you wish to connect.    This will allow you to make static bookmarks in 
the Windows Program Manager.

The Following is the command line usage:
 Usage: bcgopher  -hhostname   -pport   -titemtype   -nname   -sselector 

 -hhostname : where hostname is the ip address of the host to connect to.
 -pport     : where port is the port number of the host.
 -titemtype : where itemtype is the single character type attribute (e.g. ';' = image).
 -nname     : where name is the name you wish to associate with this item.
 -sselector : where selector is the item selector.



Please refer to your Microsoft Windows(tm) Manual for more infomration about adding icons and 
command line parameters to the Program Manager.



Selecting an Item

Once you have successfully connected to a gopher server you will be presented with the 
many different services available at that server.    

The Focus Rectangle

By clicking on a particular icon or title you will see a Focus Rectangle.    This item is now 
selected.    Any operations made will refer to this particular item.

Selecting with the Keyboard

It is also possible to use the arrow keys to move the focus rectangle around.    To open the
particular item you can double click on the item with either the left or right mouse 
button, or press the RETURN key.    The left and right mouse buttons perform different 
functions depending on the type of item you have selected (refer Viewing Items for more 
information).

Using the Binoculars to aquire Gopher+ Information

If your menu appears with the  icon this indicates that the item is a Gopher+ item.    
You will noticed that you can alternatively click so that the focus rectangle surrounds the 
item icon and tile or just the binoculors.    All functions work normally on the item icon 
and title, but now there is added functionality by using the binoculors to view other 
information.    You can aquire some more detailed attribute information about that item 
by double clicking with the left mouse button on the binoculors.    If you double click 
with the right mouse button on the binoculors you will receive a list alternate views.

Jumping to Items by Letter

In general gopher servers alphabetize their menu listings.    If you connect to a server or 
service that contains a long listing you can press the first letter of the section you wish 
(e.g. "s") and the Focus Rectangle will jump to the first occurance of an item starting with
"s" in the list.    If the focus rectangle does not jump, there are no (more) items starting 
with that character.    (note: the capital letter "A" is not he same as the small letter "a" in 
the alphebetized menus, but they are when you press the character).



Gopher+ Attribute Information

You will notices that the menu item descriptions may not contain all the information you 
may need or want to determine whether you really wish to view a particular item.    That 
is why Gopher+ has allowed for additional information.    If you have connected to a 

Gopher+ server you will see the  icon next to the item.    If you click on this icon 
with the left mouse button you will receive a dialog box containing the additional 
attibutes.

The additional attributes that may be returned are:
 INFO:    The detailed selector string that gopher+ uses to fetch an item.
 ADMIN:    Admin: Information about the administrator of the server the item is on.
           Mod-Date: The modification date of this particular item.
 VIEWS:    Alternate views available for this one particular item.

           This includes the sizes of the file in each particular view incantation.
 ABSTRACT: A short (maybe three or four lines) detailed description of this particular item.

Generally the INFO and ADMIN blocks will appear with information, however, the VIEWS 
or ABSTRACT fields may not contain data depending on whether there is any alternate 
views or an abstract for that item.



Gopher+ Alternate Views

A single item in a menu may have more then one reprecentation.    For instance, if you 
have an important document that you wish many people to be able to read you may 
want to save it in a number of formats.    You can save it in Microsoft Word for Macintosh 
for people accessing the server from a Macintosh.    You can save it in Microsoft Word for 
Windows for people accessing the server with BCGopher.    You can save it in RTF (Rich 
Text Format) for people who may have other Word Processors, or you can save it in plain 
text for the die hard character cell terminal user, or lowly DOS user.    Instead of having 
all four of these files show up in the menu you can have just one item with many views.    
If you were to just double click on the item title the file would be received using the first 
(which is the default) view.

If you don't wish this view you can double click with the right mouse button on the  
and you will receive a dialog box containing a listbox of the alternate views.    If you 
select one and click the Retreive View button in the dialog box, BCGopher will receive 
that particular view of the document in question.



Navigating Around Gopherspace

Some of these services can lie on servers located in different places throughout the 
world.    They can be anywhere from a different office at that site, a different site 
altogether, maybe even in a different country.

Any item on the menu that is represented by a folder can be one of these services, or 
can contain other information pertaining to a specific subject.

The term navigating refers to the ability to jump between different servers by using 
pointers to other servers.    You can usually jump all around the country or even the world
by starting at one site.



A rectangle surrounding an item that indicates it is the point of focus.



Viewing items

In most cases everything that is not a folder can be viewed on your local system.    To 
view a file just double click on it or select the View Item from the File Menu.    BCGopher 
allows you to customize the way in which you view documents.    From the Configuration 
Dialog Box you can specify which application you wish to use to read different types of 
documents.    If you double click on an item with the left mouse button the item will be 
brought up in the application you specified.    If the document is large the first part of the 
document will be displayed and the "Save As..." dialog will allow you to name a file 
where the entire document will be saved on your local machine.    If you double click on 
an item with the right mouse button the document will be saved in a file you name.

Other items may be binary files and, therefore, not displayable unless it is a binary 
image, sound, or movie.    In these cases if you double click with the left button, the file 
will be downloaded as a temporary file and opened up immediately for viewing and the 
subsequent temporary file deleted upon exiting BCGopher.    If you double click with the 
right button a "Save As" dialog box will ask you to name the file and then proceed to 
download it to the local computer for permanent storage.

See Also

Application Association for more information about viewing files.
Alternate Views for more information about viewing a single item in multiple ways.



Index Searches

A collection of files that pertain to the subject referred to in the title can be indexed by 
every "meaningful" word so that an interested party can do a quick search.

If you were to take all the mail messages sent to a computer support agent and put them
in a database, a person who had a problem could read these messages looking for a 
problem that was similar to his or hers and the corresponding answer.    This, of course, 
could take quite a long time.    If those messages were cross referenced by the problem 
the person would only have to look at the references to find the mail message that could 
help him.    This is the essence of an Indexed Search.    

On gopher the Indexed Search will return documents matching the particular search 
information in the form of a gopher directory.    Thus returning a document without having
had to search through the entire hierarchical structure of a server by hand.



CSO Phone Books

The CSO Phone Book is a different type of server.    It was originally written to be talked to
from a PH client.    The PH style client was written in to gopher to facilitate a way to do 
name look ups.    These phone books can contain detailed information about people at a 
particular location.

The Simple Search

When selecting a CSO Phone Book search you will be presented with a simple dialog box 
requesting the search string.    If you enter a string, the subsequent database is searched 
for this string.    There is no way, usually, to determine what fields exist, or which fields 
are involved in the search.    If you are looking for a name, the bet is pretty good that it 
will search for a name, but it may also pick up street addresses and email addresses.    
There is also no control over which fields are returned to you.    If the result of the search 
does not contain a field you were looking for it is possible to specify more information 
using the more button.

The Detailed CSO Dialog

If you select the more button in the Simple Search you will receive the detailed CSO 
Dialog.    This dialog will allow you to search on specific fields and for more then one item.
You will also be able to determine what the fields are, and have fields returned to you 
with information that may not usually be included (such as a person's pager number).

The top part of the dialog box contains the search criteria.    The left most drop-down menu 
will allow you to choose the field to apply the search criteria.    The site you connect to will 
determine the list of fields you can search on.    The center drop-down menu will allow the 
type of search you can perform.    It's possible to get an exact match, one that only contains 
the first part of the search string, or one that contains the search string anywhere in that 
field.    

If you click the and check box you will be able to specify another field and string to search 
on, allowing you to narrow your search.



The bottom part of the dialog box contains the fields to be returned by the search.    If the 
default radio button is selected the default fields are returned which may not contain all the 
fields in the database.    You can scroll the list to see what fields exist and which ones are 
returned.    If you wish any fields that are in the database but are not selected, you can 
choose the Return selected fields radio button which will allow you to change the 
selections in the list box of fields.



Telneting

When you double click on an item associated with a Telnet or TN3270 connection you will
be presented with a dialog box informing you of any information you may need, such as 
a username and / or password, to log into that remote server.    When you click the OK 
button BCGopher will launch the application associated with that specific type and 
connect you to the address pointed to by that item.    When you are in the Telnet or 
TN3270 application you are not associated with BCGopher any longer and can quit the 
application if you wish.

See also

Application Association for more information about associating a specific Telnet or 
TN3270 application with these items.



File Menu

From the File Menu you can connect to a gopher server, save an item, view information 
about an item, or exit the application.

New Gopher
Save As
View Item
Alternate Views
Attribute Info
Exit



New Gopher...

You can connect to a gopher server by specifying the internet address of the server in 
the Server Address box and the port number in the Server Port box.    For gopher the 
port number is typically 70.    Press the connect button to start the process.    The dialog 
box comes up with the default server specified in the Configuration Dialog Box.    If you 
do not specify Server Description the address will show up in the title bar.



Save As...

You can invoke this function by either selecting "Save As..." from the File Menu or by 
double clicking on the particular item with the right button of your mouse.

This menu item has two functions:

If you have selected any item that is pointing to another item (like a phone book or a 
directory) that item will be added to the bookmark list.

If you have selected any other item you will receive a "Save As" dialog box to save the 
particular document.



Exit

As you might guess, this menu item will quit the application.    When this is done any 
changes made to the configuration or the bookmark list will be saved.



Edit Menu

Cut

There is no instance in the program (so far) that causes text to be removed.

Copy

When you have selected an item the title can be copied into the clipboard to use 
elsewhere.    This does not copy the address.

If you wish to copy the address or selector string you can use the Description Box.    
When the description box is visible, you can select an item and use the CTRL-C 
accelerator keys to do the copying.

Paste

To paste something from the clipboard there must first be something there (refer to 
Copy).    The only place in BCGopher you can paste information is the Bookmark Dialog 
box.    You can, of course, paste into other applications.



Options Menu

The different options you can alter.    By choosing the appropriate menu you can change 
information about where to connect and how to view documents, the font type, and 
observe information about items.

Configuration...
Font...
Description Box



Configuration...

In the configuration dialog box you can set a number of default information:

Default Server Description

When BCGopher is first started it will use this information for display along with the 
Default Server.    Whether this information is used to connect automatically on start up,
or just as the information contained in the New Gopher dialog box.    This description will 
be placed in the title bar when connecting to the default server.

Default Server Address

The Internet Address of your favorite gopher server.    This will appear in the New Gopher 
dialog box when connecting to a new server.    If you have checked the Connect on 
Startup check box BCGopher will connect to this server when the application starts.

Default Server Port

In some rare occasions, a Gopher Server may exist at a port other then the "universal" 
default of 70.

Connect on Startup

Check this button if you wish BCGopher to connect to your Default Server 
automatically upon launching the application.

Differentiate gopher links

Check this button if you wish links to other Gopher Servers to appear different then 
directory items located on the same server.

Default Directory

Where the files that you receive when using Save As or double clicking with the right 
mouse button will automatically be placed.

Application Association

How to associate different applications with certain Item Types and file extensions.

See Making Application Associations for more information about making these 
associations.

Close Configuration

Clicking this button will save the current configuration to your BCGopher.ini file, and 
close the dialog box.

Cancel

Clicking this button will not save any changes made to the configuration, and close the 
dialog box.





Making Application Associations

There are a lot of different Item Types (refer to What is Gopher?).    Each type can have 
multiple formats.    Thus is the joy of multi platform computing.    For example, you can 
have a binary image file.    This image file can be in GIF format, JPG format, TIFF, or any 
number of other formats.    What do we do if we want to view any of these documents?    
We can find a single viewer that will recognize many formats, or we can get different 
viewers for each.    If we were to use the former method, we could just open up the 
document in the viewer and it would recognize the format and display it for you.    
However, what if we encounter a format that can only be read by one viewer and that 
viewer can not read other formats?    Well, in that case what we can do is make an 
Application Association.

BCGopher has set up the ability to associate a specific application with both an item type
and the possible extension of the file being received.

In the above list box you will notice three columns, extension, Item Type, and Application 
Path.    The way in which BCGopher works is to attempt to resolve the application by 
searching the Item Types.    If it finds more then one application for a single Item Type, it will 
then attempt to locate a filename extension in the Item Title.    In most cases, nice server 
administrators will place the filename at the beginning of the Item Title if the item is meant 
for download.    If an extension is found in the Item Title then the Item Types are searched for
a match with the file extension.    If one is found BCGopher takes the first 8 characters of 
the Item Title and parses the extension to it.    If no extension is found in the Item Title, 
BCGopher will present you with a Save As dialog box and give you the opportunity to 
choose the extension to place on the filename (not to mention, the ability to change the 
filename).



In the File Name box is the name of the target file.    If you wish to change any of this 
filename you can.    In the Save File as Type box is listed the different extensions along with 
their associated applications.    The file extension will be whatever you choose as the file 
type unless you choose the "(specified)" setting.    



Adding and Editing Associations

If you click the Add button or select an item to edit and click the Edit button you will be 
presented with an Application Association dialog box.

File Extension

You can enter any three character extension here (without the period).

Item Type

Select which item type this extension is associated with.    You can only choose from the 
list of predefined types.    (See also What is Gopher for list of types).

Application Path

It is possible to enter only the application name (e.g. "wingif") if that application is 
located in the DOS search PATH environment variable.    If it is not, or you don't want to 
bother, you can click the Browse button and choose the application this way.    When you
return from the File Open dialog box, the entire application directory path and filename 
are placed in the edit box.

Application Parameters

Some applications might need other information besides a single parameter.    There is a 
way to pass more information to an application that may need more.    In the case of a 
telnet application that needs a port number you can tack on that information using the 
parameter parsing in BCGopher.

When passing parameters we use the percent (%) convention.    This means we indicate 
the % sign and a number to show which parameter we may wish passed.

      %1    - The Item Address.
      %2    - The Item Port.
      %3    - The Item Selector.
      %4    - The Item Description.

 Example:

      Command line for telnet application you would use in the program manager:
  wtnvt bcvmcms.bc.edu 23

      Application Path & Parameter for BCGopher:
  wtnvt %1 %2

In this case, the "%1" is replaced with the address and "%2" is replaced with the port 
number.    All intervening information is kept.    For example:
  telnet /address=%1 /port=%2 /name="%4"

 can expand to:
  telnet /address=bcvmcms.bc.edu /port=23 /name="Boston College Quest System"



Here, all the other information is preserved.

Note for FTP's PC/TCP users

Execute application when download is complete

When double clicking on an item with the left mouse button, the associated application
is executed when the information has been downloaded.    The resulting file created to 
capture the information is deleted upon exiting BCGopher.    However, if you double click
on an item with the right mouse button, it is usually to permanently save the 
information to your local machine.    The resulting file is not deleted, and, in this case, 
you many opt not to activate the associated application when download is complete.

If this item is checked and you double click with the right mouse button, the 
application is activated.    If it is not checked, and you double click with the right mouse 
button, the application is not activated.

If you double click on an item with the left mouse button the application is activated 
whether this button is checked or not.



FTP's PC/TCP Users

When using version 2.2 and below of PC/TCP you should have the following as your telnet
command:
  wtnvt -t vt100 %1

If you are using 2.3 you can have the following:
   wtnvt %1 %2



The three character part of a filename located after the period.    For example, "txt" is the
extension in the filename "readme.txt".



The full directory path and filename location of an application.    If you do not specify a 
directory path, the PATH environment variable will be searched for the application.



Font...

The font in which BCGopher displays your menu can be changed and saved.    The font, 
style, and size are all saved in the BCGopher.ini.



Description Box...

The description box is a floating dialog box that will inform you of the details of a 
specified item in a gopher menu.    This includes the file type, host name, host port, and 
selector string.    You can use this information to create bookmarks or to add to gopher 
servers you may have.

If the host or selector string is too long to show in the text field you can click on the field 
and scroll the string in the edit box.    You can also select the string to copy and paste in 
other documents.

Since the box is floating it will also always remain on top of your application.    You can 
click on any item in the menu even if the box is obscuring part of the window.    If you 
can't find it or the box has been moved too far you can use the magnet button on the 
status bar  to get it to return to the bottom of the main window.    (note:    if the bottom
of the main window is at the very bottom of your screen the description box may be off 
the bottom of your screen and not visible.    If you move the bottom of your gopher 
window up and click the magnet the window will appear so that you can move it with the 
menu bar)

To remove the Description Box you can reselect the Description Box item in the Options 
Menu.



What is a Bookmark?

So, you're reading a great book and just as it gets to a good part the phone rings.    You 
just want to finish this sentence.    The phone has now rung twice, and you go to put the 
book down but slip and grab the phone before the answering machine picks it up.    You 
finally get the phone and it turns out to be a wrong number.    Unfortunately, you dropped
your book and now aren't sure where you were.    You thumb through it trying to find your
place, having to re-read things you've already read.    Flipping a few pages ahead 
(because you're sure you were far past there) you start to read and realize that, not only 
are you a few pages too far, but you just read who the murderer was without the build 
up.    If only you had had a bookmark to put in your page.

I know, we all know what a bookmark is.    But it can be just as frustrating maneuvering 
through gopherspace.    You find a site that has the one FAQ you've been looking for to 
quickly solve a problem that's been plaguing you for days.    You start reading the file and
instead of quitting out of the pager application, you mistakenly quit out of gopher.    You 
don't know what site you were connected to.    You had spent all day threading yourself 
through any number of sites.    If you were to make a bookmark of that site (or that 
specific document), you can go back there anytime you like.

If you create a bookmark to a site this stores the host address, port, and selector string 
(if needed) so that you can return to that site any time you wish by selecting it from the 
menu listing.

Bookmarks (the menu)

Add (^Add)
List...
A Bookmark
...



Add (^Add)

Once you have selected an item on your gopher menu you will be able to select the Add 
item from the Bookmark menu.    This will add the currently selected item to your 
bookmark list.    If you wish to add the current site you are currently looking at you can 
hold down the Control (CTRL) key and select the Add from the menu.    When you select
the Bookmark menu you will see a little hat (^, caret, up arrow) to indicate that you are 
adding the site and not a specified item. You can also add a bookmark by double clicking 
with the right mouse button on certain items, such as a folder, Index Search, CSO Phone 
Book, or Telnet Link.    Other file types are downloaded without being display in the Pager.



The Bookmark Dialog

From the Bookmark Dialog box it is possible to add, modify, delete and go to bookmarks.

A bookmark consists of a bookmark name, item type, host address, host port, and 
selector string.

Bookmark Name

The Bookmark name is the name in which you will remember what the service is you are 
connecting to.      This name will show up in the Bookmark Menu.

Item Type

A number that informs the client what type of item the particular service is.    For more 
information on item types refer to What is Gopher?.

Host

The internet address of the server that contains the item.

Port

The internet port of the server that contains the item.    If the item is a gopher server the 
port is typically 70.

Selector

A string, usually the path name of the item.    This is used to locate (or identify) the 
particular item on the server.    If the bookmark is referring to a server the string is blank.

The Bookmark Dialog Box Buttons

(click button for explanation)





Saves changes to current bookmark list and closes dialog box.



Discards any changes made to bookmark list and closes dialog box.



Saves any changes made to bookmark list closes dialog box and connects to current 
bookmark selected.



Allows the addition of any bookmark to the list by hand.

When choosing Add you should make sure that you have all the information you need to 
fill in the bookmark.

Bookmark Name - The name you wish to give to this bookmark.
Item Type - The type of item the bookmark is pointing to.    You can only choose from the
items in the pull down box.
Host - The internet address of the server.
Port - The port of the server.
Selector - The selector string that describes the path of the item.    If this is pointing to a 
server you must leave the selector blank.

Press the Add button again when finished adding, or Cancel to not add it.



Changes a currently entered bookmark.    You can change any part of the bookmark 
information.    Refer to Add for more information about the fields.



Removes the currently selected bookmark from your list.



Places the selected bookmark one level higher on the listing.



Places the selected bookmark one level lower on the listing.



Selecting Bookmarks

There are two major ways to connect to a site saved by a bookmark:

1. Select it from the Bookmark Menu.
2. Select it and press the Go To button from the BookMark Dialog Box.



Returning to Previous Sites

Whenever you double click on a folder the site that contains that folder is placed into the
Recent Menu.    The menu contains all the places you have gone since the application 
was started.    You can return to any of these places by selecting it from the Recent 
Menu.    A check mark will be placed next to the name of the site you are currently 
located at.

Previous Site

If you wish to return to the previous site you were at you can select the Previous Site 

item from the Recent Menu or click on the arrow button  in the status bar.



The Help Menu

Help (the menu)

Contents... is the main menu of this help section.
What is Gopher+?... is the information about Gopher+.
Navigating... information about navigating around with BCGopher.
What's New?... information about new features in BCGopher.
About BCGopher... Gives you an About dialog box.



Frequently Asked Questions.    Typically a file containing the most frequently asked 
questions about a specific subject.



About BCGopher 

BCGopher was written by:

    Edmund C. Greene
    Special Services Consultant
    Information Technology
    Boston College, Boston, Mass.
    ed@bcvms.bc.edu 

It was written in Microsoft's Visual C++ V1.5.

BCGopher is copyright 1993, 1994 - Trustees of Boston College

If you like this program please let me know (it might get me a raise).

Thank you to all the lovely people on USENET and Internet who may have helped me to 
improve this application or helped me to solve any of the many problems I encountered 
while creating this program.

Thanks to Larry Zaborski for drawing the BCGopher icon.
He will be missed.



What's New in version 0.8ba2 of BCGopher

      * Fixed bookmark bug which caused GPF

 What's New in version 0.8ba1 of BCGopher

      * Fixed the the "Save As" and "View Item" menu items.
                                            They had been acting incorrectly.
      * Fixed the "Cancel" button on the "Save As" dialog box.

 What's New in version 0.8ba of BCGopher

      * Fixed the GPF caused when sometimes using the Previous Site or Recent items.
      * Changed some user interface details in the Bookmark Dialog Box.

 What's New in version 0.8bof BCGopher

      * Added some support for Gopher+ Items using the  icon.
              Including:
                  Attribute Information
                  Alternate Views

      * Added support for command line arguements
      * Attempted (really hard) to fix all the bugs I could find.

What's to come?

      * Movement of the Application Association list box to it's own dialog box.
      * Added support in the Application Associations for the Alternate Views
      * Add Support for ASK blocks
      * Make the Bookmark menu tear away (might be awhile).

      * Any other suggestions are welcome.



 BCGopher is copyrighted 1993, 1994 The Trustees of Boston College.    All rights 
reserved.






